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Criação de documentos de alta
qualidade utilizando LATEX

Uma introdução

António dos Anjos

Instituto Superior Manuel Teixeira Gomes
antoniodosanjos@gmail.com

ISMAT Talks, 2015
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Objetivos do Worshop

Qualidade?. . . Não de conteúdo
Dar a conhecer a ferramenta LATEX
Servir de ponto de partida
Não pretende ser exaustivo
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Resumo

1 Introdução
2 Edição
3 Formatação de texto
4 Matemática básica
5 Ambientes

6 Listas
7 Tabelas
8 Figuras
9 Bibliografias
10 Miscelânea
11 Conclusão
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LATEX – O que é?

Sistema de preparação de documentos
Em especial técnicos e científicos (muitas fórmulas)
Pode ser utilizado para quase todo o tipo de publicação

posters, partituras, gráficos, etc.

Não é um processador de texto
Uma espécie de markup language (como o html)
Criado por Leslie Lamport na década de 80
Corresponde a um paginador
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TEX

O LATEX utiliza o “motor” tipográfico (formatação) TEX
O TEX corresponde a um tipógrafo
Criado por Donald Knuth (finais da década de 70)
TEX do grego τ έχνη (arte)

Por isso . . .
LATEX pronuncia-se La-tek (o X é um χ).
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LATEX – Filosofia
Sistema de tipografia

Permitir que um autor se preocupe com o conteúdo
Libertar o autor da formatação do documento
Por exemplo:

Em vez de escrever o cabeçalho de um capítulo em Arial, tamanho
24, negrito, centrado
Dizer ao LATEX: “Isto é um cabeçalho de capítulo”

Há comandos que permitem “afinar” a formatação dada pelo
LATEX, no entanto, apenas deverão ser utilizados na versão final
do documento, para pequenos (e raros) ajustes

Ideia
Deixar o design do documento para os designers (τ έχνη = arte)
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In pt-lshort.pdf página 3

Autores não qualificados cometem frequentemente erros sé-
rios de formatação assumindo que o desenho de livros é, na
sua maior parte, uma questão estética — “Se um documento é
artisticamente bonito, então está bem desenhado.” Mas, como
um documento tem de ler lido e não pendurado numa galeria de
pinturas, a leitura e compreensão é de muito maior importância
do que a sua forma.
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LATEX – Porquê?

Documentos de excelente aspeto
Grátis e Open Source
Compatível com os principais S.O.
Não sofre com vírus (e.g. MS Office)
Permite controlo total do documento
Risco muito baixo de se perder o documento
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LATEX vs. Processador de Texto

Num processador de texto (e.g. Microsoft Word)
WYSIWYG
Curva inicial de aprendizagem rápida
Potencialidades limitadas
Problemas de compatibilidade entre plataformas

Em LATEX:
What You See Is NOT What You Get (necessita compilação)
Curva inicial de aprendizagem lenta
Potencialidades “ilimitadas”
Compatível entre plataformas

Processador de Texto

Uma secção
LATEX (num editor de texto)
\section{Uma secção}
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Obter/Instalar LATEX
O “compilador”

Windows
MiKTeX – http://miktex.org

MacOS
MacTeX – http://www.tug.org/mactex

Linux
TeXLive – utilizar o gestor de pacotes

Alternativa para qualquer S.O.
Descarregar instalador apropriado de http://tug.org/texlive/
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Edição de um documento LATEX
Onde vamos escrever

Utilizando um editor “normal” (e.g. notepad, gedit, vim).
ou

Utilizando um IDE (Integrated Development Environment):
MacOS: TeXstudio1 / TeXShop (incluido no MacTeX)/
TeXmaker / TeXworks
Windows: TeXstudio / TeXniCenter / TeXmaker / TeXworks
Linux: TeXstudio / TeXmaker / TeXworks

Outros:
http://en.wikipedia.org/wiki/Comparison_of_TeX_editors

IDE: não necessita de terminal para compilar; tem atalhos para
comandos LATEX; tem correção ortográfica.

1Recomendado
Anjos (ISMAT) LATEX ISMAT 2015 11 / 80
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Para quem não quer instalar

Editor/compilador on-line (grátis com limitações):
https://www.sharelatex.com
https://www.overleaf.com
http://papeeria.com

Obrigatório ter ligação à Internet.
Performance depende da velocidade da ligação.
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Olá mundo!
Um documento simples

Estrutura mínima:

\documentclass{article} %tipo de documento

\begin{document} %início do documento

Ola mundo!

\end{document} %fim do documento
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Outras classes

article Para artigos em revistas científicas, apresentações,
relatórios curtos, documentação de programas
informáticos, convites, etc. . .

report Para relatórios mais longos com vários capítulos, livros
curtos, teses. . .

book Para livros “a sério”
letter Para cartas

standalone Útil (e.g. em conjunto com package tikz) para criar
imagens para incluir noutros documentos.

beamer Para apresentações
É possível passar opções para a classe 2, p.ex.:
\documentclass[12pt,a4paper,twoside,landscape]{article}

TeXstudio:
File→New From Template

2Detalhes: http://en.wikibooks.org/wiki/LaTeX/Document_Structure#Document_classes
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Acentos e hifenização do idioma português3

\documentclass{article}

\usepackage[portuguese]{babel} % hifenização e ...
\usepackage[utf8x]{inputenc} % acentos e cedilhas
\usepackage[T1]{fontenc} % evitar problemas c/fontes

\begin{document}
Olá mundo!
\end{document}

O preâmbulo permite, entre outras coisas, que carreguemos pacotes que
oferecem funcionalidades extra.

3Caso, em Windows, utf8 não funcione, substituir por latin1
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Encher chouriços
Pacote lipsum

O pacote lipsum, através do comando \lipsum, permite a geração de
parágrafos de texto em latim (peça clássica do ano 45 AC).

\documentclass{article}
\usepackage[portuguese]{babel}
\usepackage[utf8x]{inputenc}
\usepackage{lipsum} % texto latim

\begin{document}
Olá mundo! \lipsum

\end{document}

Sem argumentos apresenta cerca de uma página de texto. Como
argumento opcional, podemos solicitar um parágrafo específico, ou um
intervalo de parágrafos (e.g. \lipsum[2-7]).
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Ajuda

TeXstudio: Help → Latex Reference
TeXstudio: Help → Packages Help
TeXstudio: Botão direito do rato em cima do nome do pacote e
selecionar Open Package Documentation
Terminal: texdoc nomePacote
https://www.ctan.org/ Arquivo oficial de tudo o que se
relaciona com TEX

Anjos (ISMAT) LATEX ISMAT 2015 17 / 80

https://www.ctan.org/


.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

Ficheiros
Guardar o código do documento

O código LATEX deve ser gravado num ficheiro de extensão .tex
Ao ser compilado, vão ser gerados vários ficheiros
Aquele que nos interessa é o .pdf
O ficheiro .log, poderá ser útil para debugging

NOTA
Por vezes poderá ser necessário apagar alguns ficheiros resultantes da
compilação. Nunca apagar o ficheiro terminado em .tex!
Para apagar (TeXstudio): Tools→Clean Auxiliary Files
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Erros na compilação

Caso haja um problema na compilação do documento, o IDE deverá
informar-nos (janela inferior esquerda – TeXstudio).
Problemas comuns:

Chaveta aberta e não fechada, ou vice-versa
Erro de digitação de um comando e/ou palavra-chave
Escrita de comandos com maiúscula/minúscula

Apesar da linha indicada, o erro poderá situar-se noutro local.
O ficheiro .log pode ser útil em casos extremos.
Mais útil é a funcionalidade “undo”.

Sugestão
Não ficar muito tempo sem compilar (até sermos “profissionais” em
LATEX)
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Exercício
Olá mundo!

Escrever um documento com o seguinte conteúdo:

Olá mundo!
Tudo bem?

Anjos (ISMAT) LATEX ISMAT 2015 20 / 80
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Solução
Olá mundo!

\documentclass{article}
\usepackage[portuguese]{babel}
\usepackage[utf8x]{inputenc}

\begin{document}
Olá mundo!

Tudo bem?
\end{document}

Lição
Para parágrafo: deixar, pelo menos, uma linha em branco!
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Parágrafos e indentação

O LATEX insere um avanço em cada novo parágrafo. Para que os
parágrafos iniciem sem avanço, basta incluir no cabeçalho do
documento:

\usepackage{parskip}

Também é possível controlar o comprimento do avanço:
\setlength\parindent{0pt}
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Espaçamento entre restantes linhas

Para podermos definir o espaçamento entre linhas:
\usepackage{setspace}

Passamos a ter à disposição os seguintes comandos:
\doublespacing % espaço 2x
\onehalfspacing % espaço de 1,5x
\singlespacing % espaço de 1x

Passamos também a ter os ambientes respetivos, singlepace,
onehalfspace e doublespace. Por exemplo:
\begin{singlespace}
Texto em que as entre-linhas têm espaço normal.
\end{singlespace}
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Capa

Comandos importantes para a geração da capa:

\title{Workshop \LaTeX} % definir título
\author{António dos Anjos} % definir autor
\date{\today} % definir data

\begin{document}
\maketitle % gerar capa

Olá mundo?

\end{document}

Anjos (ISMAT) LATEX ISMAT 2015 24 / 80
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“Separar águas”
Estruturar o documento

O LATEX oferece 7 níveis de definição de secções de um documento:

\part{Parte} Apenas book
\chapter{Capítulo} Apenas book e report
\section{Secção} Inválido em letter
\subsection{Subsecção} Inválido em letter
\subsubsection{Sub-subsecção} Inválido em letter
\paragraph{Parágrafo} Inválido em letter
\subparagraph{Sub-parágrafo} Inválido em letter

Sugestão: Utilizar \section{Nome exercício} antes de cada exercício.
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Formatação básica de texto

Este texto está a \textbf{negrito}.

Este texto está a negrito.
—

Este texto está em \textit{itálico}.

Este texto está em itálico.
—

Este texto está \textsl{inclinado}.

Este texto está inclinado.
—

Este texto está com estilo de \texttt{máquina de escrever}.

Este texto está com estilo de máquina de escrever.
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Formatação básica de texto . . .

Este texto está \emph{enfatizado}.

Este texto está enfatizado.
—

Este texto está \underline{sublinhado}.

Este texto está sublinhado.

TeXstudio
Notar alguns atalhos para formatação na barra de ferramentas direita.
Notar ainda: LaTeX→Font Styles

Anjos (ISMAT) LATEX ISMAT 2015 27 / 80



.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

Fontes

O LATEX oferece uma gama muito vasta de fontes
VER: http://www.tug.dk/FontCatalogue/
Poderá requerer a instalação/inclusão de package

A fonte base utilizada num artigo LATEX contém serifas (serifs) –
chamadas de fontes Romanas

Para apresentações é melhor uma fonte sem serifas (sans-serif)

Este texto \textsf{não tem serifas}.

Este texto não tem serifas.
—

Este texto \textrm{tem serifas}.

Este texto tem serifas.
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Fontes. . .

Para grandes blocos de texto, podemos ativar um determinado tipo de
fonte e “desativar” quando apropriado4 (se não for desativado,
mantém-se até ao fim do ambiente)

\sffamily Este texto não terá serifas.
\rmfamily Daqui para a frente, o texto vai ter serifas.

Também podemos delimitar uma área onde o texto será de
determinado tipo

{\sffamily Este texto não terá serifas.}
Daqui para a frente, o texto volta a ter serifas.

Nota
Para regressar à fonte base, pode utilizar-se \normalfont que, em
geral, equivalerá a \rmfamily

4Ver: LATEX Cheat Sheet 5.1
Anjos (ISMAT) LATEX ISMAT 2015 29 / 80



.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

Fórmulas matemáticas
Modo inline

Para se escrever fórmulas matemáticas junto com o texto, colocar a
fórmula entre $ $.
Por exemplo:
A equação $ax + b = 0$ é de primeiro grau.
resulta em: A equação ax + b = 0 é de primeiro grau.

Carateres especiais
$ tem significado especial, assim como % _ { } & # ˆ etc.. Para serem
apresentados no texto, preceder por \ (e.g. \%).
A barra \ é apresentada através do comando: \textbackslash.
˜ e ˆ são apresentados através de \˜{} e \ˆ{}, respetivamente.
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Fórmulas matemáticas
Modo display

Para escrever a fórmula numa linha independente, colocar a fórmula
entre $$ $$.
Por exemplo:
A equação $$ax + b = 0$$ é de primeiro grau.
Resulta em:

A equação
ax + b = 0

é de primeiro grau.
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Fórmulas matemáticas
Subscrito e sobrescrito

Para sobrescritos, utilizar ˆ. Exemplo:
A equação $ax^2 + bx + c = 0$ é de segundo grau.
Resulta em:

A equação ax2 + bx + c = 0 é de segundo grau.

Para subscritos, utilizar _. Por exemplo:
$x_1+x_a = x_{1a}$
Resulta em:

x1 + xa = x1a

NOTA: { } permite agrupar. Por exemplo, x10 escreve-se $xˆ{10}$, e não
$xˆ10$, que resultaria em x10.
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Exercício
Teorema de Pitágoras

Se c1 e c2 são os catetos de um triângulo retângulo, então a hipotenusa
h pode ser calculada pela seguinte fórmula:

h2 = c2
1 + c2

2

Solução
Se $c_1$ e $c_2$ são os catetos de um triângulo retângulo,
então a hipotenusa $h$ pode ser calculada pela seguinte
fórmula: $$h^2 = c_1^2 + c_2^2$$
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Raízes

A seguinte equação
h2 = c2

1 + c2
2

equivale a
h =

√
c2

1 + c2
2

Para o símbolo de raiz quadrada, utiliza-se o comando \sqrt{}. Por
exemplo:
$h = \sqrt{c_1^2 + c_2^2}$
Para outras raízes, utiliza-se o comando \sqrt[ ]{}:
$h = \sqrt[4]{c_1^2 + c_2^2}$ %raiz quarta

NOTA: Em LATEX, argumentos obrigatórios são colocados entre { }, argumentos
opcionais colocam-se entre [ ].
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Frações

Uma fração pode ser expressa de várias formas:

Pretendido: Em LATEX:
a/b
ou

a ÷ b
ou
a
b

$a/b$
ou
$a\div b$
ou
$\frac{a}{b}$
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Letras e símbolos

Letras gregas, em geral, escrevem-se como se dizem (em inglês). Por
exemplo, α escreve-se $\alpha$, β escreve-se $\beta$, etc.

A versão maiúscula é escrita com a primeira letra maiúscula. Por
exemplo, ∆ escreve-se $\Delta$.

Para outras letras/símbolos, consultar tabela fornecida.

Alternativa: Detexify
(http://detexify.kirelabs.org/classify.html)

NOTA: Não há comando para letras com o mesmo aspeto que no alfabeto
português. Por exemplo, α maiúsculo correponde a A, desta forma, não existe
$\Alfa$.
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Exercício
Fórmula resolvente

A solução da equação de segundo grau ax2 + bx + c = 0 é dada pela
fórmula resolvente:

x =
−b ±

√
b2 − 4ac

2a

Solução
A solução da equação de segundo grau $ax^2+bx+c = 0$
é dada pela fórmula resolvente:
$$x = \frac{-b \pm \sqrt{b^2 - 4ac}}{2a}$$
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Funções matemáticas

O LATEX também tem comandos para funções matemáticas. Por
exemplo:

Pretendido: Em LATEX:
sin 2θ

cos (θ + 5)
tanϕ
lg 16
lg x
logb a

$\sin{2\theta}$
$\cos{(\theta+5)}$
$\tan{\phi}$
$\lg{16}$
$\lg{x}$
$\log_b{a}$
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Exemplos mais avançados

Pretendido: Em LATEX:
∞∑

i=1

1
i

10∏
n=1

n
n − 1

lim
x→∞

1
x∫ ∞

0
2x dx = x2 + c

\sum_{i=1}^{\infty}\frac{1}{i}

\prod_{n=1}^{10}\frac{n}{n-1}

\lim_{x\to\infty}\frac{1}{x}

\int_0^\infty 2x\,dx = x^2+c
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Funções e fórmulas matemáticas
Recursos

Para muitos mais comandos e exemplos:
http://www.artofproblemsolving.com/wiki/index.php/LaTeX:
Commands

Para desenhar a fórmula e obter o LATEX:
https://webdemo.myscript.com/#/demo/equation
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Exercício
Definição de derivada

Seja f uma função, então:

f ′(x) = lim
∆x→0

f (x +∆x)− f (x)
∆x

caso o limite exista. . .

Solução
Seja $f$ uma função, então:
$$f^\prime(x) = \lim_{\Delta x \to 0}
\frac{f(x+ \Delta x) - f(x)}{\Delta x}$$
caso o limite exista\ldots
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Ambientes

Um ambiente em LATEX é um bloco de código que se pode “comportar”
de forma diferente do resto do documento.

Em LATEX: Exemplo:

\begin{nomeAmbiente}
...
\end{nomeAmbiente}

\begin{abstract}
...
\end{abstract}
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abstract
Ambiente para definição do resumo

\begin{document}

\title{Workshop \LaTeX}
\author{António dos Anjos}
\date{2014-04-24 (última revisão)}
\maketitle

\begin{abstract}
Este documento é sobre \LaTeX.
\end{abstract}

\section{Intro}
Olá mundo?

\end{document}
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quote
Ambiente para citações

Em LATEX: Resultado:

1 Niels Bohr disse: ``Um
2 especialista é alguém que
3 já cometeu todos os erros
4 possíveis numa área muito
5 específica.''
6 Albert Einstein disse:
7 \begin{quote}
8 Quem nunca cometeu um erro
9 nunca tentou nada de novo.

10 \end{quote}
11 Herrar é umano.

Niels Bohr disse: “Um
especialista é alguém que já
cometeu todos os erros
possíveis numa área muito
específica.” Albert Einstein
disse:

Quem nunca cometeu
um erro nunca tentou
nada de novo.

Herrar é umano.

NOTA: As aspas de abertura são dois acentos graves e, as de fecho, duas plicas.
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Ambientes para alinhamento
Atenção! Não apenas para texto.

Em LATEX: Resultado:

1 \begin{flushright}
2 Alinhado à direita.
3 \end{flushright}
4

5 \begin{center}
6 Texto centrado.
7 \end{center}
8

9 \begin{flushleft}
10 Alinhado à esquerda.
11 \end{flushleft}

Alinhado à direita.

Texto centrado.

Alinhado à esquerda.

TeXstudio: notar barra de
ferramentas lateral.
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Ambientes de manipulação do tamanho do texto
Relativo ao tamanho atual em utilização

Em LATEX: Resultado:

1 \begin{small}
2 Texto menor.
3 \end{small}
4

5 Texto normal.
6

7 \begin{large}
8 Texto grande.
9 \end{large}

10

11 \begin{Large}
12 Texto maior.
13 \end{Large}

Texto menor.

Texto normal.

Texto grande.
Texto maior.

TeXstudio: notar barra de
ferramentas superior. LATEX

Cheat Sheet 5.2: notar que
podemos utilizar sem ambiente.
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equation
Ambiente para a criação de equações numeradas

Em LATEX: Resultado:

1 \begin{equation}
2 (x-a)^2 + (y-a)^2 = r^2
3 \end{equation}

(x − a)2 + (y − a)2 = r2 (1)

Note-se o número (1) produzido ao lado da equação. Desta forma,
podemos fazer referência à equação, no texto.
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label e eqref
Referência automática de equações

Em LATEX: Resultado:

1 Podemos referir-nos à equação
2 abaixo, por causa da label
3 que foi adicionada.
4

5 \begin{equation}\label{eq:circ}
6 (x-a)^2 + (y-a)^2 = r^2
7 \end{equation}
8

9 Estou a referir-me à Equação
10 \eqref{eq:circ}. Se criar
11 outras equações antes, a
12 referência atualiza-se.

Podemos referir-nos à equação
abaixo, por causa da label que foi
adicionada.

(x − a)2 + (y − a)2 = r2 (2)

Estou a referir-me à Equação (2).
Se criar outras equações antes, a
referência atualiza-se.
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align
Ambiente para alinhamento de equações

O ambiente align é oferecido pelo pacote amsmath. Desta forma,
temos de incluí-lo no preâmbulo.

Em LATEX: Resultado:

1 \documentclass{article}
2 \usepackage{amsmath}
3 \begin{document}
4 \begin{align}
5 2\cos(x) +3y &= 20\\
6 24x + \tan(2y) &= 10
7 \end{align}
8 \end{document}

2 cos(x) + 3y = 20 (3)
24x + tan(2y) = 10 (4)

O caráter & indica qual o símbolo a ser utilizado para alinhamento,
neste caso, o =. Para remover numeração: align*.

Anjos (ISMAT) LATEX ISMAT 2015 49 / 80



.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

Exercício
Resolver a equação

Vamos derivar as funções definidas nas Equações (5) e (6).

f (x) = ax2 + bx + c (5)

g(x) = dx3 (6)

As funções e respetivas derivadas, são:

f (x) = ax2 + bx + c g(x) = dx3

f ′(x) = 2ax + b g′(x) = 3dx2

Anjos (ISMAT) LATEX ISMAT 2015 50 / 80



.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

Solução
Resolver a equação

1 Vamos derivar as funções definidas nas
2 Equações \eqref{eq:equ0} e \eqref{eq:equ1}.
3 \begin{equation}\label{eq:equ0}
4 f(x) = a x^2+b x +c
5 \end{equation}
6 \begin{equation}\label{eq:equ1}
7 g(x) = d x^3
8 \end{equation}
9 As funções e respetivas derivadas, são:

10 \begin{align*}
11 f(x) &= a x^2+b x +c & g(x) &= d x^3 \\
12 f^\prime(x) &= 2 a x +b & g^\prime(x) &= 3 d x^2
13 \end{align*}
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enumerate
Ambiente para listas ordenadas

Pretendido: Em LATEX:

Lista de alimentos:
1. Legumes
2. Carne
3. Fruta

3.1 Laranja
3.2 Morango

4. Cereais

1 Lista de alimentos:
2 \begin{enumerate}
3 \item Legumes
4 \item Carne
5 \item Fruta
6 \begin{enumerate}
7 \item Laranja
8 \item Morango
9 \end{enumerate}

10 \item Cereais
11 \end{enumerate}
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itemize
Ambiente para listas não ordenadas

Pretendido: Em LATEX:

Lista de alimentos:
Legumes
Carne
Fruta

Laranja
Morango

Cereais

1 Lista de alimentos:
2 \begin{itemize}
3 \item Legumes
4 \item Carne
5 \item Fruta
6 \begin{itemize}
7 \item Laranja
8 \item Morango
9 \end{itemize}

10 \item Cereais
11 \end{itemize}
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.

description
Ambiente para listas descritivas

Pretendido: Em LATEX:

Lista de cadeiras:
AED Algoritmia

M1 Matemática I
M2 Matemática II
P1 Programação

1 Lista de cadeiras:
2 \begin{description}
3 \item[AED] Algoritmia
4 \item[M1] Matemática I
5 \item[M2] Matemática II
6 \item[P1] Programação
7 \end{description}
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Exercício
Listas e fórmulas

Vamos escrever algumas fórmulas dentro de uma lista:
A equação geral da reta é y = mx + b.
Vamos simplificar (a + b)2:

(a + b)2 = (a + b)(a + b) (7)
= a2 + ab + ab + b2 (8)
= a2 + 2ab + b2 (9)

Este é o último item da lista, e não tem fórmula.
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Solução
Listas e fórmulas

1 Vamos escrever algumas fórmulas dentro de uma lista:
2 \begin{itemize}
3 \item A equação geral da reta é $y=mx+b$.
4 \item Vamos simplificar $(a+b)^2$:
5 \begin{align}
6 (a+b)^2 &= (a+b)(a+b)\\
7 &= a^2 + ab + ab + b^2\\
8 &= a^2 + 2ab + b^2
9 \end{align}

10 \item Este é o último item da lista, e não tem fórmula.
11 \end{itemize}
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tabular
Abiente para tabelas

Exemplo 1

1 \begin{tabular}{|c|r|}
2 \hline a & bb \\
3 \hline ccc & dddd \\
4 \hline
5 \end{tabular}

a bb
cccc dddd

Exemplo 2

1 \begin{tabular}{l|c}
2 a & bb \\
3 \hline ccc & dddd \\
4 \end{tabular}

a bb
ccc dddd
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table
Ambiente para “enfeitar” tabelas

Para podermos adicionar legenda (caption) à tabela, temos de
envolver o \tabular numa \table:

1 \begin{table}
2 \begin{tabular}{|c|r|}
3 \hline a & bb \\
4 \hline cccc & dddd \\
5 \hline
6 \end{tabular}
7 \caption{Tabela com legenda.}
8 \end{table}

a bb
cccc dddd

Tabela 1: Tabela com legenda.

Caso desejemos fazer-lhe referência, é necessário adicionar uma label (a
seguir à caption) e referir-se à label através do comando \ref{}.
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Exercício
Tabela campeonato 2010/2011

A Tabela 2 apresenta a classificação do campeonato nacional de futebol
da época 2010/2011. Note-se que esta se encontra centrada na página,
a primeira coluna está alinhada à esquerda, a última à direita e, as
restantes, centradas.

Tabela 2: Classificação liga portuguesa – 2010/2011

Equipa J V E D M S Pts
F.C. Porto 30 27 3 0 73 16 84
S.L. Benfica 30 20 3 7 61 31 63
Sporting 30 13 9 8 41 31 48

Anjos (ISMAT) LATEX ISMAT 2015 59 / 80



.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

Solução
Tabela campeonato 2010/2011

1 A Tabela \ref{tab:camp} apresenta a classificação ...
2 \begin{table}
3 \begin{center}
4 \caption{Classificação liga portuguesa -- 2010/2011}
5 \label{tab:camp}
6 \begin{tabular}{lccccccr}
7 \hline\hline
8 Equipa & J & V & E & D & M & S & Pts \\
9 \hline

10 F.C. Porto & 30 & 27 & 3 & 0 & 73 & 16 & 84 \\
11 S.L. Benfica & 30 & 20 & 3 & 7 & 61 & 31 & 63 \\
12 Sporting & 30 & 13 & 9 & 8 & 41 & 31 & 48
13 \end{tabular}
14 \end{center}
15 \end{table}
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Gráficos

Para incluirmos gráficos no documento, é necessário utilizar o package
graphicx.

1 \documentclass{article}
2 \usepackage{graphicx}
3 \begin{document}
4 \includegraphics{imagem}
5 \end{document}

A imagem deverá estar na mesma diretoria que o documento LATEX, ou
então é necessário indicar o caminho (e.g.
\includegraphics{/home/aanjos/imagens/imagem}).
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includegraphics
Opções

1 \includegraphics[width=5mm]{imagem}
2 \includegraphics[width=10mm]{imagem}
3 \includegraphics[scale=0.2]{imagem}
4 \includegraphics[width=10mm, angle=45]{imagem}
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figure
Ambiente para “enfeitar” gráficos

Para podermos adicionar legenda (\caption) à figura, temos de
envolver o \includegraphics numa \figure:

1 \begin{figure}
2 \includegraphics{imagem}
3 \caption{Careca com bigode.}
4 \end{figure}

Figura 1: Careca com bigode.

Caso desejemos fazer-lhe referência, é necessário adicionar-lhe uma
label e referir-se à label através do comando \ref{}.
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Exercício
Texto e figura

A Figura 2 foi gerada utilizando o pacote tikz — em LATEX.

Figura 2: Figura gerada utilizando o tikz.
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Solução
Texto e figura

1 A Figura \ref{fig:tikz} foi gerada utilizando
2 o pacote \textbf{tikz} --- em \LaTeX.
3 \begin{figure}
4 \includegraphics[width=\textwidth]{valve}
5 \caption{Figura gerada utilizando o \textbf{tikz}.}
6 \label{fig:tikz}
7 \end{figure}
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Bibliografia

Pode incluir-se no próprio documento, utilizando o ambiente
thebibliography
Em geral faz mais sentido colocar a bibliografia num ficheiro
externo (no formato BibTeX)

Um ficheiro com extensão .bib que vai servir de base de dados de
referências bibliográfica
Muito fácil encontrar referências no formato BibTeX (e.g. Google
Scholar)

No documento, citamos apenas as que desejamos
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Biliografia
Ficheiro BibTeX (.bib)

Trata-se de um ficheiro simples de texto. Exemplo:
@book{gratzer2000math,

title={Math into LATEX},
author={Gratzer, George},
year={2000},
publisher={Birkhauser/Springer-Verlag}

}

@article{lamport1986latex,
title={LaTEX: User's Guide \& Reference Manual},
author={Lamport, Leslie},
year={1986},
publisher={Addison-Wesley}

}
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JabRef
Gerir a base de dados .bib

Em vez de editar o ficheiro de referências diretamente, utilizar o
programa JabRef (http://jabref.sourceforge.net/).

Permite a criação de referências de raiz, ou por colagem da referência
copiada a partir da Internet.
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Biliografia
Definir parâmetros

Para se poder fazer referência a um artigo que conste na base de dados,
primeiro, é necessário informar o LATEX sobre:

qual o estilo de bibliografia que desejamos
onde se encontra a base de dados

Visto que a bibliografia, em geral, vem na parte final do documento,
podemos fazer isso por, antes de \end{document}, escrever:

\bibliographystyle{plain}
\bibliography{nomeFicheiro}

Agora podemos fazer citações utilizando \cite{nomeRef}.
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Exercício
Bibliografia – \cite{ }

Sir Isaac Newton formulou as leis do movimento e da gravitação
universal [1]. Estas leis alteraram a forma como se via o mundo até
então [2].

[1] Isaac Newton, Daniel Bernoulli, Colin MacLaurin, and Leonhard
Euler.
Philosophiae naturalis principia mathematica, volume 1.
excudit G. Brookman; impensis TT et J. Tegg, Londini, 1833.

[2] Wikipedia.
Isaac newton — wikipedia, the free encyclopedia, 2015.
[Online; accessed 9-April-2015].
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Solução
Bibliografia

1 Sir Isaac Newton formulou as leis do movimento e da
2 gravitação universal \cite{isaacPrincipia}. Estas
3 leis alteraram a forma como se via o mundo até
4 então \cite{isaacWiki}.
5

6 \bibliographystyle{plain}
7 \bibliography{bdRefs}
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Tabela de conteúdos

Após termos o nosso documento
estruturado apropriadamente, a
criação de uma tabela de conteúdos
é tão simples quanto digitar
\tableofcontents. (Talvez logo
após o abstract).

\documentclass{article}
\usepackage[portuguese]{babel}
\usepackage[utf8x]{inputenc}

\begin{document}
\tableofcontents

\section{Intro}
Olá mundo?
Tudo bem?

\section{Teste}
Tudo bem. Adeus.

\end{document}
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Apêndices

Para definir apêndices, basta utilizar o comando \appendix, e
declarar secções

\begin{document}

\section{Intro}
Olá mundo?
Tudo bem?

\appendix % todas a seções seguintes são apêndices
\section{Material adicional}

Aqui temos um apêndice

\section{Mais material}
Aqui temos outro apêndice

\end{document}

Anjos (ISMAT) LATEX ISMAT 2015 73 / 80



.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

Comandos úteis

\pageref{etiqueta} devolve o número da página onde a label etiqueta
foi definida

\listoffigures gera a lista de figuras
\listoftables gera a lista de tabelas

\newline inicia nova linha
\noindent remove a indentação do parágrafo respetivo
\clearpage inicia nova página

\cleardoublepage inicia página em nova folha (útil para two-sided)
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Pacotes úteis
apenas alguns. . .

Informática
minted código fonte com syntax hightlighting

clrscode3e pseudocódigo
gastex grafos e autómatos

Matemática
amsmath escrita de fórmulas matemáticas
amsthm teoremas e provas

Química
mhchem fórmulas químicas

mychemistry esquemas de reação
chemfig moléculas

Eletrónica
circuitikz circuitos eletrónicos
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Pacotes úteis
mais alguns. . .

Música
musicxtex música polifónica ou instrumental

guitarchordschemes acordes e tablaturas
abc notação musical

Diversos
geometry permite redefinir as margens

parskip retirar indentações dos parágrafos
glossaries glossários, acrónimos e símbolos

tikz toda a espécie de diagrama
siunitx ajuda na escrita em unidades padrão

hyperref hiperligações
booktabs alternativa interessante ao ambiente tabular

xcolor texto colorido e outras operações com cor
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Pacotes úteis
ainda. . .

Diversos (continuação)
subcaption imagens ou tabelas lado a lado

fancyhdr personalizar cabeçalhos
multicols páginas com mais de duas colunas
setspace modificar espaçamento entre linhas
framed molduras e sombreados
lettrine capitulação

draftwatermark marcas de água
multirows fundir células de tabelas

tabularx auto-ajuste de colunas, dado o tamanho da tabela
longtable tabelas de múltiplas páginas

leaflet folhetos desdobráveis
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Recursos úteis

http://en.wikibooks.org/wiki/LaTeX
http://www.latex-tutorial.com/
https://www.sharelatex.com/learn/Portuguese
http://www.tug.dk/FontCatalogue
https://www.tug.org/texshowcase/
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Leitura Recomendada

[1] Kottwitz, Stefan. LaTeX beginner’s guide. Packt Publishing Ltd,
2011.

[2] Oetiker, Tobias, et al. "Uma não tão pequena introdução ao
LATEX2ϵ." Tradução portuguesa por Alberto Simões (2007).
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That’s all
folks!

. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .. .
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